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Introduction

StudyMate Author® by Respondus® is a Windows authoring tool that makes it easy to create web-based learning activities and games. When creating a StudyMate file, the focus is on the substance of a topic, not the requirements of a particular activity or game. This is a more natural approach for instructors and makes it easier to use content that might already exist in other formats.  

Four types of items can be created or imported by StudyMate Author: Fact items, Term/Definition items, Multiple Choice, and Calculated items. All four item types can reside in the same StudyMate file. 

“Fact” Items

A “Fact” item consists of a fact, a statement, or a body of text. The following fact would be an example of a Fact item: Albert Michelson determined the speed of light in 1879. The StudyMate Author activities that can be generated with Fact items include:

Fact Cards 

Fact Cards +
“Term/Definition” Items

A “Term/Definition” item has a word/phrase that is associated with another word/phrase. A common example is a glossary “term” that has a related “definition.” Another example is a fill-in-the-blank “question” in which the “answer” is a specific word or phrase. The StudyMate Author activities that can be generated using Term/Definition items include:

Flash Cards

Pick a Letter

Fill in the Blank

Matching

Crosswords

Glossary

“Multiple Choice” Items

“Multiple Choice” items are questions that have multiple distracters but only one correct answer. The StudyMate Author activities that can be created with Multiple Choice items include: 

Quiz

Challenge

"Calculated" Items
"Calculated" items, sometimes known as algorithmic items, require students to apply a mathematical formula to answer the question presented.  Calculated items are designed for using variables with random values, based on a specified range, that are automatically generated for each variable in the question.  The StudyMate Author activities that can be created with Calculated items include:
Quiz

Challenge

StudyMate Author exports the activities and games to StudyMate.com with a web link the instructor can post to anywhere and is accessible by students with a web browser including most mobile web browsers on smartphones and similar handheld devices. 
StudyMate Author additionally offers direct integration with ANGEL (version 6.3 and higher), Blackboard Learning System (version 7.3 or higher), Blackboard Learn (version 9.x or higher), and Blackboard Vista/Campus Edition (version 8.0) with links to the activities on StudyMate.com, as Adobe Flash (.swf) activities or as SCORM 1.2+ modules.

StudyMate Author will also export the activities and games in Adobe Flash (.swf) format that instructors can upload to other learning management system such as Moodle, Desire2Learn and Instructure Canvas along with any web site, web service or web application that supports Adobe Flash (.swf) files. 

Computer Requirements

StudyMate Author requires Windows XP or higher, 32 MB of RAM, 5 MB of free hard disk space, and at least an 800x600 monitor resolution (1024 x 768 recommended). For previewing activities, Internet Explorer must have the Adobe Flash Player installed (version 7.0 or higher).
Installation & Setup

To begin the installation process, download the StudyMate installation file from http://www.respondus.com for the StudyMate Single-user license. For StudyMate Campus-wide licenses, obtain the installation file from the institution's Respondus Campus-wide Local Support Contacts. Once the file has been downloaded; locate the StudyMate25.exe file (or StudyMate25Campus.exe) that was downloaded to your hard drive. Double-click the file to start the StudyMate Author installation program and follow the instructions on the screen. Once StudyMate Author is installed, start the program by double-clicking the StudyMate Author icon that appears on the Windows desktop. Or, follow these steps to start the software.

1. Click [Start] from the Windows desktop

2. Click [Programs]

3. Click [Respondus]

4. Click [StudyMate Author]

The first time you start StudyMate Author (and each time thereafter until the program is registered), you will be presented with a screen to register StudyMate Author 2.5.
StudyMate Author Registration

StudyMate Author Single-User license 
The first time you start StudyMate Author (and each time thereafter until the program is registered), you will be presented with a screen that provides the “Product ID#”. The Product ID# is used to obtain the Activation Password (see below) which is needed to complete the installation.

Once the StudyMate Author installation program is finished, you will need to obtain a password from www.respondus.com to activate the installation. Be sure to have the StudyMate Author “Product ID#” readily available. After you have directed your browser to http://www.respondus.com, go to the “Registration” section of the site. You have the choice of purchasing a permanent activation password for StudyMate Author or obtaining a 30-day trial password. In both cases you will be required to enter a valid e-mail address and the Product ID# that displays on the opening screen of StudyMate Author. Once the information is submitted, the activation password is immediately sent to the e-mail address you specified. 

Once the password is received by e-mail, it must be entered into the StudyMate Author program. If you haven’t done so already, start StudyMate Author and then enter the password when prompted (you may want to “copy and paste” the password from the e-mail message in order to prevent typing mistakes). Click [OK] to continue. The StudyMate Author software is now activated, either permanently or for a 30-day trial period. 

StudyMate Author Campus-wide License

The first time you start StudyMate Author, you will be presented with a screen prompting for your institution's Campus-wide license information. Please contact your institution's Respondus Campus-wide Local Support for the license information and additional assistance with registering the Campus-wide license.

Online Help & User Guides

StudyMate Author includes a full-featured help system that includes an index and context-sensitive help. To view the on-line help, choose “Help Topics” from the pull-down Help menu and select a topic. You can also press the F1 key from within StudyMate Author to obtain context-sensitive help. Throughout the program you will additionally see small buttons having a “?” symbol. When the button is clicked, information on that particular option or task is provided. 

If you encounter a question that is not answered in the online help or in the StudyMate Author User Guide, you are encouraged to visit the “Support” section of the Respondus web site (www.respondus.com). There you will find a Knowledge Base and other resources. 

The remainder of this user manual is organized according to the five StudyMate Author menus: Start, Edit, Settings, Preview & Publish, and StudyMate.com.

Start Menu 

Overview of Start Menu

Opening a File
Opening and Converting a Respondus file

Downloading Publisher Test Banks

Creating a File
Import Wizard
Quick Copy Wizard
Overview of Start Menu

The Start menu provides the ability to Open a StudyMate Author file, Create a new file, and Import questions from a word processing, text, or IMS QTI file. The Quick Copy Wizard additionally provides an easy way to create an activity from an existing set of StudyMate files. 

A StudyMate file must be open before you can go to another menu in StudyMate Author.

Opening a File

From the Start menu, click the Open button. The following window will appear:
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Highlight a StudyMate project by clicking it once. To obtain information on the project, select one of the two center buttons located above the “Selected File” window at right. The “Item List” button (right of center) is used to view a list of the items contained in the highlighted file. To preview a particular item, click the “Title.”

To open a highlighted file, click the [Open] button at the bottom of the window. (Double-clicking a file name will also open it.) 

StudyMate Author allows projects to be organized within sub-folders. For example, you may want to organize StudyMate projects by class, course, or subject matter. To create a new folder, locate the toolbar above the “Selected File” window and click the “Create New Folder” button located second from left. To navigate down a level within a folder, double-click the folder itself. To navigate up a level, click the “Up One Level” button located leftmost on the row of buttons. To save a StudyMate Author file into a subfolder, open the StudyMate Author file, select "Save As…" from the File menu and navigate to the new subfolder when prompted for a file name and location.
The [Search] button allows the text in a file to be searched prior to opening it. 

The [Browse…] button, located on the lower left side of the Open window, allows you to locate a StudyMate file (.rsf) that is located elsewhere on the hard drive and copy the file to the StudyMate Projects folder. It does not move the file or open it directly; rather, it creates a new “projects” folder based on that file. 
The [Download Test Bank] button is used to start the Respondus Test Bank Network wizard to register and download a publisher test bank
Opening and Converting a Respondus file

The Browse button can also be used to select and then convert a Respondus project file (.rsp) or a Respondus archive file (.rsa, .rpa) to StudyMate format. To do so, click [Browse...] and then change the pull-down list for “Files of Type” to “Respondus Files and Archives.” Upon selecting a Respondus project or archive file, various options will be offered regarding the conversion of the Respondus file to StudyMate format. Select the desired options and click [OK] to complete the conversion.
Note, the Import Wizard can also be used to convert a Respondus file to StudyMate format.

Downloading Publisher Test Banks

The [Download Test Bank] button is used to download publisher test banks that have been made available through the Respondus Test Bank Network (for more details, see http://www.respondus.com/testbank). To download a test bank, enter the File Code that has been supplied to you by the publisher. If applicable, also enter the password and any additional information that has been provided to you. StudyMate Author will then locate and download the test bank file. Since the file being downloaded is in Respondus format, it will need to be converted to StudyMate format. Following the download step, StudyMate Author will display various options regarding the conversion of the file to StudyMate format. Select the desired options and click [OK] to complete the conversion.

Creating a File

From the Start menu, select the Create button to create a new file. You are prompted to enter a File Name and Description (both are required), as well as Author and Keyword information (optional). Click [OK] to create the file. You are now ready to add items to the file, using either the Edit menu or the Import Wizard. 

Import Wizard
StudyMate Author allows the importing of Fact, Term/Definition, and Multiple Choice items.  Calculated items can also be imported, but only if they are in Respondus (.rsp) format. For text imports, the file must be formatted according to the guidelines discussed later in this section. Once the text is in the proper formatting, the Import Wizard will guide you through the importing process, as discussed here.  

Step 1
Start the Import Wizard and select the file format being imported: 

* MS Word 2007-10 (.docx)

* MS Word 97-2003 (.doc), Rich Text (.rtf), Text (.txt)
* IMS QTI (.xml)

* Respondus (.rsp) or Respondus Archive (.rsa, .rpa)
* StudyMate Class format (.zip, .xml)
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The first two options (.docx, .doc, .rtf, .txt) are self-explanatory. If the file being imported is in one of these formats, then select one of these two options.
Note: Importing questions from the Microsoft Word 2007-2010 .docx format requires that Word 2007 or Word 2010 be installed on the same computer. The .docx format has better support for importing text with formatting like auto-numbers and auto-letters along with embedded images.

IMS Question & Test Interoperability (IMS QTI) is a series of specifications that are supported by various e-learning systems (for more information, see http://www.imsglobal.org/question/). If an IMS QTI XML file is being imported, StudyMate Author will use only the multiple choice and true/false questions, filtering out the rest of the content. 

Respondus is a separate authoring tool by Respondus Inc. that allows you to create assessment content for use with the leading course management systems (for more information, see http://www.respondus.com). Many question types from Respondus files (.rsp) or Respondus Archive Files (.rsa, .rsp) can be imported with StudyMate Author.
StudyMate Class is a separate application and a web-based version of StudyMate that resides within the online course. Files can be exported from a StudyMate Class project for import into StudyMate Author. Respondus files can also be saved as StudyMate Class format files for import into either StudyMate Author or StudyMate Class.

Step 2

If you are importing an IMS QTI XML file, Respondus file or StudyMate Class file, skip to the instructions provided in Step 3. For MS Word .docx, .doc, Rich Text (.rtf), or Plain Text (.txt) file, the next screen in the wizard will ask whether the text being imported is formatted for Multiple Choice, Term/Definition, Fact items, or Mixed Item Type (MS Word.docx only). It’s important to note that only one type of item can be imported at a time from MS Word .doc, Rich Text .rtf or Text .txt formats (see the formatting requirements described below for each question type). To import more than one type of item to a StudyMate file use the MS Word .docx file, or repeat the importing process for each file of one type of items.
When “MS Word 2007-10 (.docx)” is selected, a Mixed Item Types option allows the file to have a combination of the different item types: Multiple Choice, Term/Definition, and Fact items. The next screen will remind you of the formatting for Mixed Type Items must follow the guidelines in the online help and as discussed later in this section.
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If “MS Word 97-2003 (.doc), Rich Text (.rtf), Text (.txt)” is selected, the next screen will remind you that the text formatting for Multiple Choice, Term/Definition, and Fact items must follow the guidelines for the Standard Format, as discussed later in this section.
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Step 3
The final screen of the wizard requires several actions. Click “Browse” to locate and select the file being imported. 
Next, indicate whether the items being imported should be appended to the currently open file or whether an entirely new StudyMate file should be created. If the second option is selected, you will additionally need to enter the name of the file being created.
Each item being imported is given a “title.” If titles aren’t specified in the file being imported, StudyMate Author will create a title using the first 20 characters of the item wording. Alternatively, it is possible to specify “stem” text (i.e., a prefix) that will then be followed by consecutive numbering starting with 001. For example, if you select the “Use stem...” checkbox and enter the text “Chapter1-” the title for the first item being imported will be Chapter1-001, the title for the second item will be Chapter1-002, and so on. (You do not have to enter stem text--this feature is entirely optional.)

Click the [Preview] button to preview the file being imported and to see if there are any warning messages. If warning messages are shown at the bottom of the screen, you need to decide whether to make changes to the file being imported or whether to continue without making changes. (Note, if a Respondus file is being imported, an additional window containing conversion options will appear. Select the desired options and click [OK] to continue.)  Be aware that some warning messages don’t actually require that changes be made to the file being imported. For instance, StudyMate Author will generate a warning message if two items being imported have the same title (StudyMate Author will automatically place the number “2” at the end of the second title to make it distinct from the first). In this example, if you don’t care that StudyMate Author is making a minor change to the title, ignore the warning message.
If you are satisfied with how the results look in Preview, click [Finish] to complete the import. The StudyMate file is now created or appended. Switch to the Edit menu to further modify the file, or go to the Preview task to view the items.  

Formatting a text file for importing into StudyMate Author
StudyMate Author can import fact, term/definition and multiple choice questions from a MS Word 2007-2010 document (.docx), a MS Word 97-2003 document (.doc), a rich-text file (.rtf), or a text file (.txt). If using the .docx format, StudyMate Author can import a mix of fact, term/definition and multiple choice questions from a single document.  Otherwise, only one type of item can be imported at a time from a MS Word .doc, Rich Text .rtf or Text .txt formats. The specifications for formatting the items for importing from a file can be found in Appendix A: The StudyMate Author Standard Format for Importing Items 

The .doc and .rtf files cannot contain images or embedded objects, such as tables. If a StudyMate warning indicates that the document being imported contains images or embedded objects, the easiest way to strip these items is to save the file to .txt format. An alternative is to import a MS Word 2007-2010 .docx file, a Respondus .rsp file or Respondus .rsa archive file with questions that contain images. However, be aware that other advanced elements such as multimedia may not be imported.

Quick Copy Wizard

The Quick Copy Wizard is the easiest way to select and copy items from two or more StudyMate files. To begin, select the Quick Copy Wizard button from the Start menu. The first page of the wizard provides the option of creating a new file or opening an existing StudyMate file and then copying items to it. Make your selection and click [Next]. If you selected the option to create a new file, provide a name and description of the file. If you selected the option to use an existing file, open the desired file as prompted. Click [Next] to continue. 

The next page of the wizard prompts you to select the StudyMate files from which the questions will be copied. Highlight a file and click the [Select] button. Repeat this process until all files from which you want to select questions are selected. Click [Next] to continue.

The next page of the wizard prompts you to select a source file from the previous step. If the selected file has items that have been assigned to “topics,” the list can be further filtered by selecting a topic from the “Show items by topic” list.  
You then have the choice of using Automatic Selection or Manual Selection. When Automatic Selection is chosen, the available number of questions for each type of item is displayed in the “Available to Select” column. In the next column, enter the number of questions to be selected for each type of item. When all entries are finished, click either the [Add to End of List] button or the [Insert Into List] button. Repeat this process for each of the source files. 

The Manual Selection option allows the items for each file to be viewed before making a selection. In fact, you can preview individual items by clicking the magnifying glass icon. You can also search the entire list of questions using the [Keyword Search] option at top right. To select questions from this list, simply click the narrow column furthest to the left--a mark will appear next to the question. When finished with the selections, click either the [Add to End of List] button or the [Insert Into List] button. Repeat this process for each source file. 

Note that the Automatic Selection and Manual Selection options may be combined. A file can also be reselected from the pull-down list and have additional items chosen from it. StudyMate Author will prevent you from selecting an item more than once. 

Once items have been added to the list at the bottom of the screen, the Difficulty values can be edited manually. To delete an item from the bottom list, or to move it to a different location in the list, click pull down the contexts menu next to the magnifying class icon and select the desired option. Finally, notice that a tally of the questions appears at the top right corner of the lower grid.

The next and final page of the wizard is self-explanatory. For example, to edit items in the file, select the option to go to the Edit menu. To preview the activities, select that option, and so on.  Click [Finish] to complete the wizard. 

Editing a File

Overview
Common Features Across all Item Types
Question List and Expanded View
Item Types and Activities
1) Fact

Fact Cards

Fact Cards+

2) Term/Definition

Flash Cards

Pick A Letter

Fill in the Blank

Matching

Crosswords

Glossary

3) Multiple Choice

Quiz

Challenge

4) Calculated 

Advanced Editing
Adding Bold, Italics, Underline, and Super/Subscript

Web Links

Adding Images

Inserting Audio

Equation Editor

Power Editor

Spell Check

Keyword Searches

Modifying, Rearranging, and Deleting Items

A Rapid Authoring Technique for Creating Items
Using an Item as the Basis for a New Item
Copying Questions from Another StudyMate File
Overview of Edit Menu

The Edit menu in StudyMate Author allows new items to be added to a file or current items to be edited. Four types of items can be created: Fact, Term/Definition, Multiple Choice and Calculated. Up to ten activities can be created from these items.
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Common Features Across All Item Types

Four types of items can be created with StudyMate Author: Fact, Term/Definition, Multiple Choice, and Calculated. To create a new item, select the desired type from the left side of the screen. The entry form to its right will change accordingly; the activities that can be generated from that type of item are also listed.

Each item allows the entry of a “Title.” A title can be up to 60 characters. If you do not enter a title, StudyMate Author will use the first 20 characters from the next data entry field. 

Two optional features are available with each edit form: Difficulty level and Topic. The Difficulty level can be set between 1 and 5 (1=Low, 5=High). Items can also be assigned to a Topic, either an existing one or a newly created one. The small buttons located to the right of the Difficulty and Topic options determine whether an entry for that item is required. If the asterisk is selected, it becomes a required entry field.  

Four buttons appear at the bottom of all edit forms. The [Add to End of List] button adds the current item to the end of the “Item List” (located at the bottom of the screen). Use [Insert Into List] to insert the current item to a specific position in the Item List.

The [Clear Form] button will erase all data that currently shows in the form. Finally, the [Preview] button opens a browser-like window that shows how the item will appear when exported as an activity. The Preview window, which can be selected at any stage in the editing process, includes a pull-down list at top that allows a different activity or game to be previewed. 
Question List and Expanded View

At the bottom of the Edit menu, the “Item List” displays the title, format, topic, difficulty and wording for each item in the file. The first column enables you to preview an item by clicking the magnifying glass icon.  The context menu in the next column will display a pop-up dialog with various operations that can be performed on that item.
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The context menu offers the following operations:

Preview – Preview the item.

Edit – Edit the item.

Delete – Delete the item.

Move to # - Move the question to a new location in the list.

Use As Basis For New Item – Open the item in the edit template and use it as the basis for a new item.  The original title will be modified slightly – for example, the number “2” will be added to the end of the name.

Copy Items From Another File – Items can be selected and copied from another StudyMate file into the current file.

Properties – Displays a window that summarizes the properties for the item.

The [Expanded View] button, located at the top right of the Question List, displays a full screen pop-up of the question list. This enables you to view more items at once.
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Item Types and Activities
There are four types of items in StudyMate Author (Fact, Term/Definition, Multiple Choice, and Calculated). Several games and activities can be generated from each type of item. These are described below.
1) Fact
Use a Fact item to enter a fact, statement, or any text that doesn’t have a precise answer. The following fact is an example of a Fact item:



Albert Michelson determined the speed of light in 1879.

The StudyMate Author activities that can be created with Fact items include Fact Cards and Fact Cards+. 

Fact Cards

Fact Cards are one-sided cards that display text on them.
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Click Next or Previous to scroll through the cards. Shuffle will randomize the deck of cards and Reset will return you to the first card in the deck. 

Fact Cards+

Fact Cards+ is identical to Fact Cards except that it additionally sorts the cards into topics. The topics are then displayed along the left side of the activity. An item can be assigned to a topic during the editing or import steps.
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2) Term/Definition 

A Term/Definition item has a word/phrase that is associated with another word/phrase. A common example is a glossary “term” that has an associated “definition.” Another example is a fill-in-the-blank “question” that has a specific word or phrase for the “answer.” 

Example: 



Term or Answer: Albert Einstein


Definition or Question: Developed the General Theory of Relativity
The StudyMate Author activities that can be created with Term/Definition items include Flash Cards, Pick a Letter, Fill in the Blank, Matching, Crosswords, and Glossary.
Flash Cards

Flash Cards are two-sided cards that display the term/answer on one side of the card and the definition/question on the second side of the card. 
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contents of each card.

A government form in which religious officials have legal
and complete political authority and in which religious
law is enforced by state agencies.
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Click Flip Card to see the second side of the card. Select Next or Previous to scroll through the deck of cards. Shuffle randomizes the deck of cards and Reset returns you to the first card in the deck. The Display Other Side First option determines which side of the card is shown first. 
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Pick a Letter

Pick a Letter displays the definition/question at the top of the screen and has the user type or click the letters contained in the answer. If a letter appears more than once in an answer, all uses of that letter will be displayed when it is selected.  
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If an incorrect letter is entered, 1 point (of a possible 5 points) is deducted for that question. A user can continue answering the question even after the point value reaches zero.
Next Question proceeds to the next question in the list; no points are awarded if the answer isn’t completed before clicking Next Question. Hint reveals the next letter or character in the answer; one point is deducted for each hint until the point value for the item reaches zero. Show Answer reveals the entire answer; no points are awarded when this option is used. Reset starts the activity over again.

Once the final item is answered, a score will be displayed. 
Fill In the Blank

Fill in the Blank displays the definition/question in the top section and has the user enter the exact term/definition for the answer. If the answer isn’t exactly correct, StudyMate provides a hint based on the text entered in the previous attempt. One point (of a possible 5 points) is deducted for each incorrect attempt. There is no limit to the number of attempts allowed, even if the point value for the item reaches 0. 
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Next Question moves you to the next question in the list; no points are awarded if the answer isn’t completed before clicking Next Question. Hint reveals the next letter or number in the answer; one point is deducted for each hint until the point value for the item reaches zero. Show Answer reveals the complete answer; no points are awarded when this option is used. Reset starts the activity over again.
Once the final item has been answered, a score will be displayed. 

Matching

The Matching activity displays the definition/question in the top section and has the user select from one of the nine term/answer windows below. The answer windows don’t change until six correct answers have been revealed. At that time the nine answer windows are repopulated and the sequence repeats itself.

It’s important to understand that the contents of the nine answer windows are randomly drawn from other items in the file. This works well if all Term/Definition items in the file are similar (eg. all items are persons, or all items are events, or all are definitions). However, if the Term/Definition items are a mixture of topics it may be desirable to exclude the Matching activity when generating the activities. 
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There must be at least 9 Term/Definition items in a file before StudyMate will allow the Matching activity to be created.
Next Question moves you to the next question in the list; no points are awarded if the prior item isn’t answered before clicking Next Question. Show Answer reveals the answer for the item; no points are awarded when this option is used. Reset starts the activity over again.

Crosswords

A Crossword puzzle displays the “clue” (i.e. the definition or question) at the bottom of the screen and requires the user to enter the “answer” in a corresponding, highlighted area of the grid. Answers are entered one letter at a time and it’s possible to switch to another clue before supplying any or all letters for the answer. Tallies for “correct” and “missed” letters are provided, with the possibility of multiple misses occurring for a single square. 

Play begins by clicking a white, unanswered square. A highlight appears around all letter-boxes that comprise the answer, while the clue for the item is displayed at the bottom of the screen. The user can select a letter from the keyboard or from the palette of characters on the right side of the screen. International characters or numbers can be selected from the palette by first clicking the “>>>” button to reveal additional items. A puzzle is complete when all letter boxes have been solved.
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“Reveal Letter” displays the letter for the highlighted square and increases the “Missed” tally by one. “Solve Puzzle” reveals all remaining letters for the puzzle; no changes occur to the “Correct” or “Missed” tallies. The “Next Puzzle” button, when displayed, clears the current puzzle and skips to the next round (if one is available). The “Correct” or “Missed” tallies are unchanged when Next Puzzle is clicked.  
“Reset” refreshes the screen, clears the tallies, and starts the first puzzle again. Puzzles are not recompiled when the Reset button is clicked, just started again.

If an answer has multiple words (“ICE AGE”), the blank space between words will be eliminated (“ICEAGE”). Special characters ($, %, #) and punctuation ( - ,?) are revealed at the start of a puzzle. 

When publishing the Crossword activity to StudyMate.com, the puzzles are created each time a student accesses the activity. Different students will be presented with different puzzles each time.

When exporting as Adobe Flash module or a SCORM module, the puzzles are compiled in the StudyMate Author authoring tool, before they are exported to Adobe Flash format. Thus, a crossword puzzle will be the same each time a student uses it. 

The Crosswords activity in StudyMate draws its data from the “Term/Definition” template. Only those terms/answers that have 15 or fewer characters will be used during the compilation of a puzzle. If the StudyMate file has more than about a dozen “Term/Definition” items, it can generate multiple puzzles (or “rounds”) from the available data. The Settings menu StudyMate Author lets the instructor specify the maximum number of rounds permitted for a puzzle, ranging from 1 to 10. 

The Settings menu also allows the instructor to control when crossword puzzles are compiled, which can take up to 4 seconds per puzzle round. The compilation time is dependent on how many “Term/Definition” items are contained in the file and how many puzzle rounds are being permitted (a Setting option). Another setting determines whether a puzzle is compiled each time the Preview task is selected in StudyMate Author or only if a change has been made to the StudyMate file. 

Glossary

The Glossary tool provides an alphabetic listing of all Term/Definition items in the file. The term/answer is presented first, immediately followed by the definition/answer. Click a letter at the top of the screen to list the terms that start with that letter. The “other” category listed at the end of the alphabet will display terms that start with numbers, punctuation or special characters. The “All” option will list all Term/Definition items in the file alphabetically. To locate a glossary item that contains a particular word or phrase, use the Search feature. 
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Baroque

An artistic style that began in Iltaly and spread throughout Europe between
the 17th century and mid 18th century. It is characterized by dramatic
themes and highly ornate use of materials such as marble, gilt and
pediments.

Bronze Age

The middle period of prehistoric culture (2100-700 B.C.E.) when humans
first learned how to use metal.

Buddhism

A religious philosophy founded in Asia in the 6th century B.C.E. by
Siddhartha Gautama that teaches that you can achieve the final liberation of
Nirvana by "letting go" of both indulgence and abstinence and maintaining a
middle path through life.
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Note that it may be necessary to exclude the Glossary activity when generating the activities if the Term/Definition items don’t use a “term-definition” approach. For example, if the Term/Definition items are math problems in which the answer is a number, they won’t make a very useful glossary. 
3) Multiple Choice

A Multiple Choice item displays a question, followed by a list with one correct answer and several distracters.  

Example:
3) Who determined the exact speed of light?

a. Albert Einstein

b. Albert Michelson

c. Thomas Edison

d. Guglielmo Marconi

Answer “feedback” can be included with Multiple Choice questions so that students can view additional information about the answer. For example, the following feedback might be displayed after a student answers the above question (regardless of whether the correct or incorrect answer was submitted):

Albert Michelson was the first American to win the Nobel Prize in Physics (1907) for his measurements of the speed of light. His experiments laid the groundwork for Einstein’s Theory of Relativity.

To add feedback to a Multiple Choice question, click the [Feedback] button to open an editing window. When the feedback text has been entered, click the [X] at the top right corner of the feedback window to close it. 

It’s possible to have the answer choices (distracters) displayed in random order for a question. Simply select the “randomize” box. 

The following StudyMate Author activities can be created with Multiple Choice items: Quiz and Challenge.
Quiz
A Quiz will show one multiple choice question at a time. The question wording is presented at the top of the screen with the answer choices shown below it. The correct answer is selected by clicking on the letter that represents it.
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After an answer is selected, the “Next Question” button will flash and stay highlighted. If feedback is set to display immediately after a question is answered (see the “Settings” section below), the screen will indicate whether the answer is correct or wrong and will display any feedback entered for that question.  
Reset starts the quiz again without any changes to the quiz itself. Shuffle also starts the quiz again but additionally randomizes and/or reselects the questions from a larger set of questions (again, depending on the “Settings” that have been selected). 

Upon completion of the Quiz activity, a score will be presented. The user will have a chance to review the incorrectly answered questions at this point. 

Challenge

Challenge presents multiple choice questions in a fun, game-show environment. The game board consists of 5 topics, where each topic has 5 questions with point values that range from 100 to 500. 
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At the start of the Challenge game, select the “One Player” or “Two Player” option. The Two Player mode additionally allows names to be entered for the players or teams. 

The game is started by clicking one of the point values below a topic. The question and answer choices are listed in the box below. The correct answer is selected by clicking on the letter that represents it. Players are immediately shown whether the answer is correct or wrong. If the answer selection is wrong, the correct answer will be displayed in green text and the incorrect answer will appear in red. If feedback is available for the question, it too will be displayed at this time.

Challenge makes use of the “Difficulty” option that is available when multiple choice questions are created or imported with StudyMate Author. Questions will be distributed within a topic according to its original difficulty weighting (1=low, 5=high). Questions that don’t have a difficulty level assigned to it are treated as a “3” in terms of difficulty. If there aren’t enough questions within the various levels of difficulty, StudyMate Author will distribute the questions the best that it can. 

Challenge also uses the “Topics” option that is available when questions are created or imported with StudyMate Author. Questions that haven’t been assigned to a topic will be displayed under a “Mixed Topics” heading during the Challenge game. A minimum of 5 topics with at least 5 items each is recommended to avoid “Mixed Topics” headings.
The point value indicated when a question is selected will be applied to the player’s total score for the game. If the player answers the question correctly, the “total score” will increase by that amount. Conversely, if the answer is answered incorrectly, the score will be reduced by that amount. Negative scores are very much possible!
Show Answer will immediately display the correct answer to the question. Only 100 points are deducted if the Show Answer option is used. Thus, a “wild guess” may not be the best strategy when playing against another partner or team since the penalty for using Show Answer may be less. 
4) Calculated

Calculated items require students to apply a mathematical formula to answer the question. Calculated items are designed using variables. Random values, based on a specified range, are automatically generated for each variable in the question. Thus, Calculated items can be unique for each student, as illustrated in this example where values are inserted for {x} and {y}. 

Example: If a car is traveling {x} miles per hour for {y} hours, how far does it travel (in miles)? 

The following StudyMate Author activities can be created with Calculated Choice items: Quiz and Challenge.

The StudyMate editor for Calculated items requires that the following sections be completed:

· Question Wording

· Formula

· Variable Properties

· Answer Properties

· Value/Answer Sets

Calculated – Question Wording

In the Question Wording section, enter the text of the question just as you would for any other question type. However, instead of using specific numerical values to define the details of the question, instead use variables by specifying a name enclosed in curly brackets for each one. For example: “How long does it take to travel {x} miles at a speed of {y} mph?”

Variable names can only contain letters and digits (the characters 0-9, a-z, and A-Z), and the “_” (underscore) character. However, the first character of a variable name cannot be a number and the variable names “e” and “pi” should not be used.

You can use as many different variables as you need to define the question, and you can use the same variable name multiple times if necessary.

Calculated - Formula

In the Formula section, enter the mathematical formula associated with the question. This is the same formula that the student will be expected to use, and the same one that will be used to automatically calculate the correct answer for grading purposes. The same variables specified in the question wording will be used to indicate where each value should go in the formula.

The formula can be typed into the edit field directly, or entered by selecting options from the pull-down lists provided for Variables, Functions, Operators, and Constants. Selected options will appear in the edit field at the current cursor location, and will overwrite the current selection (if any).

The “Variables” list provides an easy way to select a common variable name.

The “Functions” list provides the following supported mathematical functions:

abs(x)

Absolute value of x. abs(-3) = 3.

acos(x)

Arc-cosine of x in radians

acosh(x)
Hyperbolic arc-cosine of x in radians

angle(x,y)
Arc-tangent of x/y in radians. Uses signs to determine result quadrant.

asin(x)

Arc-sine of x in radians

asinh(x)
Hyperbolic arc-sine of x in radians

atan(x)
Arc-tangent of x in radians

atan2(x,y)
Same as angle(x,y)

atanh(x)
Hyperbolic arc-tangent of x in radians

ceil(x)

Round x up to the nearest integer. ceil(2.1) = 3. ceil(-2.1) = -2.

cos(x)

Cosine of x in radians

cosh(x)
Hyperbolic cosine of x in radians

exp(x)

Base e (Euler’s constant) raised to the power of x

fact(x)

Factorial of x. fact(3) = 6.

floor(x)
Round x down to nearest integer. floor(2.8) = 2. floor(-2.8) = -3.

int(x)

Return integer portion of x. int(4.32) = 4. int(-4.32) = -4.

ln(x)

Base e natural logarithm of x

log(x)

Same as ln(x)

log10(x)
Base 10 logarithm of x

max(x,y,…)
Return the maximum of all supplied arguments. max(1,2,3) = 3.

min(x,y,…)
Return the minimum of all supplied arguments. min(1,2,3) = 1.

mod(x,y)
Modulus or remainder of x/y. mod(5,2) = 1.

rand()

Return a random number between 0 and 1

round(d,x)
Round x to d decimal places. Halfway cases round away from 0.

sin(x)

Sine of x in radians

sinh(x)

Hyperbolic sine of x in radians

sqrt(x)

Square root. sqrt(9) = 3.

sum(x,y,...)
Return the sum of all supplied arguments. sum(1,2,3) = 6.

tan(x)

Tangent of x in radians

tanh(x)
Hyperbolic tangent of x in radians

Note that the values for trigonometric functions are expressed in radians, not degrees. For conversion purposes, Pi radians = 180 degrees. Also, for all formulas that have two correct answers (for example, the square root of 9 is +3 and -3), only the positive number will be treated as correct.

After selecting a function from the list, the formula must be edited to replace the argument list with numbers or variables. For example, “round(d,x)” might be edited to specify a fixed number of decimal places and a variable to round, as in “round(3,{y})”, which would round the variable {y} to 3 decimal places.

Functions can also be nested within a formula, as in “sqrt(abs({x}))”. In this case, the absolute value of {x} is evaluated first, followed by the square root of the result. Functions can be nested as deeply as necessary to properly calculate the answer.

When entering numerical values, scientific notation is expressed in the format xEy, where x is the coefficient and y is the exponent. To convert numbers from scientific notation to standard notation, use x times 10 to the power of y. For example:

· 3.2E4 equals 32000

· -2E0 equals -2

· 3.14E-2 equals 0.0314

The “Operators” list provides the following standard mathematical operators:

-
Subtraction

()
Parentheses used to group elements for precedence

*
Multiplication

**
Power or exponent. For example, 2**3 = 8.

/
Division

+
Addition

The “Constants” list provides the following commonly-used numerical constants:

_e
Base e or Euler’s constant (2.71828…)

_pi
Pi – the circle ratio (3.14159…)

Some example questions and associated formulas might be:

Question: How long does it take to travel {x} miles at a speed of {y} mph?

Formula: {x}/{y}

Question: What is the positive square root of {x}?

Formula: sqrt({x})

Question: Compute sin(x) where x = {x} degrees.

Formula: sin({x}/180*_pi)
Calculated - Variable Properties

Clicking the “Variable Properties” button in the Formula section displays the Variable Properties dialog. Here, each variable in the question wording and formula is listed by name, along with Minimum, Maximum, and Scale values for that variable.

The Minimum and Maximum define the range of values each variable can be assigned, and the Scale specifies the number of decimal places each value should be allowed before the value is rounded off.

You can click each cell in the grid to edit the specific minimum, maximum, or scale value you want to change (the variable names cannot be edited). In general, for a given variable the minimum must be less than or equal to the maximum, and the scale must be greater than or equal to 0 and less than or equal to 5.

Calculated - Answer Properties

Clicking the “Answer Properties” button in the Formula section displays the Answer Properties dialog. Here you can specify values for answer scale and acceptable tolerance, as well as a unit name if required.

Answer scale can be specified in Decimal Places. If the answer scale is specified in decimal places, the value must be greater than or equal to 0 and less than or equal to 5, just as with the scale values specified in the Variable Properties dialog. 

Answer tolerance is the amount that the student’s answer can deviate from the calculated answer and still be considered correct. It can be specified as a numeric value or as a percentage of the answer value.

If you choose to require a unit name, comparisons with the name entered by the student will be case-insensitive and space-insensitive.

Calculated - Value/Answer Sets

Clicking the “Value/Answer Sets” button below the Formula section displays the Value/Answer Sets dialog. Here you can generate sets of variable values and calculate the associated answers using the formula previously entered. When the Calculated item is presented to the student, one of these value sets will be randomly chosen to populate the variables in the question wording and the formula, and the associated answer will be used to grade the student’s response.

The grid displays a list of numbered value/answer sets. The number of sets available can be selected from the “Number of Sets” pull-down list. If images or equations are included in the question wording, a maximum of only 10 sets can be selected. The contents of this list will vary, depending upon the complexity of the question wording. For each set, the generated values for each variable are shown, and the individual cells can be clicked to edit those values. Note that any manually-entered values must be within the range specified by the variable minimum and maximum in the Variable Properties dialog. The answers cannot be edited; instead, the “Update Answers” button can be clicked to recalculate the answers for all value sets. 
Feedback
Answer “feedback” can be included with Calculated item so that students can view additional information about the answer. For a Calculated item however, the feedback would need to be very generic due to the multiple value/answer sets.  
To add feedback to a Calculated item, click the [Feedback] button to open an editing window. When the feedback text has been entered, click the [X] at the top right corner of the feedback window to close it. 

Advanced Editing
Adding Bold, Italics, Underline, and Super/Subscript
StudyMate Author makes it possible to add bold, italic, and underline to words. Simply highlight the text you want to modify and click the appropriate [B], [I], or [U] button on the tool bar. The text will immediately change to the selected formatting. The superscript [X2] and subscript [X2] tools function in the same manner. To remove the formatting, highlight the text again and reselect the corresponding button from the toolbar.   Caution should be used when using formatting other than bold, italic, and underline in Calculated items. When advanced formatting (subscripts/superscripts, images and the equation editor) is used in Calculated item and the activity is exported as an Adobe Flash module, StudyMate Author must store each variation of the problem as an image instead of as text data, which greatly increases the size of the published Flash object.
Web Links

The Web Links tool on the toolbar lets you add a link to a website or to a file that is located on another web server. A new browser window will open when the user clicks on the web link from within the activity. 

To create a web link, select the Web Link icon from the StudyMate Author toolbar and then follow the instructions for adding a web link. A link to a specific web page can be created, or you can create a link to a media file that resides on another server. In both cases, you will be prompted to enter the text that is to be displayed for the link itself. 

A Web Link cannot be used if a text field already has advanced formatting, such as images, equations, tables, super/subscript. Similarly, if a text field has a Web Link, you’ll be prevented from adding advanced formatting, such as images and equations.
Adding Images
Images can be added to most text fields in StudyMate Author. When exporting as an Adobe Flash module, images should be used sparingly because they can significantly increase the size of the Flash object. 

From the Edit menu, position the cursor in the text field where you want the image to be added. Then click the “Insert image” icon on the toolbar, which is represented by a camera. A pop-up window will let you navigate to and select the image, provided that it is in one of these formats: bmp, gif, jpeg, png, pcx, and emf.
After selecting an image, the following window appears:
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If the image is over 400 x 300 pixels, StudyMate Author will reduce it to the required size. An image can be made even smaller by manually adjusting the value for the “Scale to” field.  

Alternate text for images can be entered in the field provided. ALT text for accessibility is supported when activities are published to StudyMate.com. For activities exported as Adobe Flash modules, ALT text is not supported in the Flash objects. 
Click [OK] to close the window and return to the Edit menu. You will now see a set of green characters like <PIC_1> that represents the image. Be sure to preview all images prior to saving the item to the file. This will assure that the image size and position is as intended. 

To delete an image, position the cursor in the same field where the item is located. Then click the “Insert Image” icon on the toolbar (the camera icon) and select the option to delete an existing image or file.

It’s important to understand that images can significantly increase the size of the final activities files, particularly if high-color photos and images are used. A high-color image may be three times the size of a similar image that uses 256 colors. Also keep in mind when exporting activities as Adobe Flash modules that they work differently than the HTML5-based activities published to StudyMate.com.  Unlike HTML-based web pages, a Flash object must be fully downloaded before anything can be viewed. 

If a large number of images will be contained in a StudyMate file, consider optimizing the images to a "web-friendly" format and size. Save screen captures and similar complex image files in PNG format and save photos in JPG format instead of BMP. Simple line art and similar clip art are best saved as GIF files.

Also reduce the overall pixel size of the image. Currently, 800 x 600 pixel resolution is an acceptable image size. Note that some image editors will only shrink the "viewable" size of the image while still retaining the original pixel resolution and file size. Verify the image has actually been reduced in pixel resolution before adding to a StudyMate item.

The Preview task available from the “Preview & Publish” menu displays the overall size of the Flash object if Export as Adobe Flash module will be used. This will help you determine whether a StudyMate activities file is becoming too large.
Inserting Audio

The Insert Audio tool allows for audio to be embedded directly into StudyMate activities.  This feature should be used sparingly since audio files can use large amounts of space and can significantly increase the size of the final StudyMate activity file. (Consider placing larger audio files on a separate server and using the Web Link tool in StudyMate Author instead.)
To embed an audio file, from the Edit menu, position the cursor in the text field where you want the link for the embedded audio file to appear.  Click the “Insert audio” icon on the toolbar, which is represented by a musical note surrounded by sound waves.  The following pop window will appear: 
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First, indicate the audio format of the file being selected, MP3 or WAV.  MP3 formats are preferable as they usually maintain quality with a smaller file size.  Both WAV and MP3 files can be created easily on a computer with a microphone or headset using many readily available audio recording programs such as Audacity (http://audacity.sourceforge.net). Many digital audio recorders also record in both WAV and MP3 format.
Next, choose the [Browse] button to browse to a location on your hard drive to where the Audio file is located. Once a file is selected, click [Open].  MP3 files cannot be altered (sampled) within StudyMate Author; instead they must be encoded properly during the recording process or with audio editing programs.  However, compression quality and size can be selected for uncompressed WAV files which can be stored as 8-bit mono with a sample rate of 5.5, 11, or 22 KHz.  Higher sample rates increase the quality but use much more space and create a much larger StudyMate activities file. If audio quality is important consider converting to the MP3 file format prior to adding to a StudyMate item or use the Web Link tool to link to a high quality audio file on another web server.
The overall size of a StudyMate activity can be determined within StudyMate Author by going to the >Preview & Publish Tab > Preview >Preview the File.  At the bottom of the preview window itself, a number will be displayed, such as "Flash object size = 168 K".  It is important to note that a file size of 480 K will require about 2 minutes downloading using low bandwidth connections but often less than 10 seconds using a high speed bandwidth connection.
The next step is to enter the text for the link that the user will click to hear the audio file.  The audio file can be previewed if desired.  If satisfactory, choose [Finish] to complete the embedding of the audio file.

When using audio files with other advanced formatting features (subscripts/superscripts, the equation editor, images, and web links) it is important to understand that StudyMate stores the wording for a question or answer choice as an image and not text data.  In this situation, the link for the audio clip will appear after the question text, and the phrase "[clip 1 below]" will appear in place of the text for the link. .  
Equation Editor

The process of adding equations is similar to how images are added. From the Edit menu, position the cursor at the place in the text where the equation is wanted. Then click the “Equation Editor” button on the toolbar, which is represented by a summation symbol. The Equation Editor will open and you can begin creating the equation. The Equation Editor in Respondus works almost identically to the one that is available with Microsoft Word and many learning management systems. So if you’ve used those equation editors, you’ll already know how to use this one. A key thing to learn about the Equation Editor is that the top row consists of “symbols” while the bottom row consists of “palettes”. If you select a “symbol” from the top row, it’s no different than if you selected the + or = sign on your keyboard -- except that the symbols from the Equation Editor eventually get displayed as graphics. When a “palette” is selected from the bottom row, text can be entered at various insertion points. It’s also possible to select a palette from the bottom row, click in an insertion point, and then select a symbol from the top row. For more information about the Equation Editor, refer to the online help that is available from within the editor. 

When finished editing the equation, exit the Equation Editor by either clicking the [X] that appears at the top right corner of the window or by selecting File from the menu bar and clicking Exit (do not simply minimize the Equation Editor). A new window appears that allows you to adjust the scaling of the equation. To accept the default setting of 150%, simply click [OK]. 

Alternate text for equation images can be entered in the field provided. ALT text for accessibility is supported when activities are published to StudyMate.com. For activities with equation images exported as Adobe Flash modules, ALT text is not supported in the Flash objects.
Once an equation has been added and you return to the Edit menu, you will see a set of green characters like <EQ_1> that represents the equation image. Be sure to preview all equations prior to saving the item to the file. This will assure that the image size and position is as intended. 

To modify or delete an equation, position the cursor in the same field where the equation is located. Then click the Equation Editor icon on the toolbar and select the option to modify or delete an existing equation. 

Using MathType with StudyMate Author
The Equation Editor in StudyMate Author is a special version of MathTypeTM by Design Science. If you frequently create documents with equations, you may find MathType is better suited to your needs. MathType is as easy to use as the Equation Editor and has many extra features to help you save time and create a wider range of equations. 

For further information about purchasing MathType, contact your software dealer or Design Science directly: Design Science, Inc., 140 Pine Avenue, Long Beach, CA 90802, USA. 


Toll free: 800-827-0685
    International: 562-432-2920

Fax: 562-432-2857

Email: sales@dessci.com


Web: http://www.dessci.com

If you already own MathType, you will need to reinstall it in order to have it work directly with StudyMate Author. MathType's readme file explains that it sets itself up to replace Equation Editor at the time that it's installed. So if you add a new application like StudyMate Author that uses the Equation Editor, you must re-install MathType.

Power Edit

The “Power Edit” task available from the Edit menu provides a table editor and a larger workspace for editing large blocks of text.

Click in the field that you want to edit and then click the “Power Edit” button on the toolbar. Most tasks on the Power Edit toolbar also appear on the main toolbar. Only the Table editor is unique. 

Tables

StudyMate Author makes it possible to insert and edit simple tables. From the Edit menu in StudyMate Author, position the cursor at the location where you want to insert the table. Then click the “Power Edit” button and select the “Insert Table” icon from the toolbar. When the next pop-up window appears, specify the number of columns and rows that should be included in the table. Click the [OK] button to return to the Power Edit window. You can now click within the cells of the table and enter the text. 

The width of the table cells can be adjusted by dragging the column lines. To edit other aspects of the table from the Power Edit menu, click within the table and select the desired action from the pull-down menu labeled “Table.” Use the “Insert” option to add a row or column to the table. Use the “Delete” option to delete a row or column, or to delete the entire table. 

Finally, keep in mind when exporting as an Adobe Flash module that tables will eventually be turned into graphics so that they can be displayed in the Flash object. So use tables sparingly since they will increase the overall size of the Flash object.

Spell Check

The Spell Check feature, which is located on the toolbar for the Edit menu, will search the currently open file for spelling errors and allow corrections to be made. Once the Spell Check feature is started, it will search for words that do not match items stored in the dictionary. If the word is not found in the dictionary, you are given the option to “Change” the word to one that is suggested, to “Ignore” the identified word, to “Change All” such words in the file to one you select, or to “Add” the word to the dictionary. If you want to make more detailed changes to the question, click the “Edit This Question” button, which will close the spell checker and make the question available for editing. 

Three dictionaries are included with a standard installation of StudyMate Author: American English, Canadian English, and British English. However, a free bundle of supplemental dictionaries can be downloaded from the Respondus website, including French, German, Spanish, Dutch, Finnish, and a comprehensive medical dictionary.

Keyword Searches

There are several places in StudyMate Author where the [Advanced Search] or [Keywoard Search] button appears, such as at the bottom of the Edit menu, at the top of the Expanded View and in the Quick Copy Wizard. Keyword searches are also available with [Search] in the “Open StudyMate File” dialog when a file is being opened. This option allows you to search the currently open file or the file that is being previewed. 

Up to three words can be included in a search. When more than one word is used, you can choose whether a match is required of all words or any of the words. The search can be further filtered by selecting a topic from the pull-down list (if the items have been assigned to a topic). A final option allows answer choices and feedback to be included in the search. 

Modifying, Rearranging, and Deleting Items

It is easy to modify, move, or delete an item in StudyMate Author. From the Edit menu, pull down the context menu next to an item in the “Item List” Select Edit to modify the item, Delete to delete the item and Move to place the item at a different position in the Item List. If you select the Edit button, you will be returned to the Edit screen and the current properties for that item will be displayed in the form--modify the item as you like. When modifying an item, notice that the two buttons at the bottom of the form now indicate “Save Changes” or “Cancel Changes”. If you want to save the changes to the item, select the corresponding button. If you don’t want the changes to be implemented, select [Cancel Changes]. 
A Rapid Authoring Technique for Creating Items 
If you plan to use the same basic content across the Multiple Choice, Term/Definition, and Fact templates, the following rapid authoring technique can be employed.
Starting with the Multiple Choice template, complete the fields as normal.  Before adding the item to the list, click the checkbox "After saving this item, use it to create a "Term/Definition" item".  The Multiple Choice item will be saved and StudyMate Author will automatically switch to the Term/Definition template. The Term/Definition template will be populated with text from the previously entered Multiple Choice item, but make sure the wording makes sense for the new Term/Definition item being created. Before adding the new Term/Definition item to the item list, select the checkbox "After saving this item, use it to create a "Fact" item". Once the Term/Definition item has been saved, StudyMate Author will now switch to the Fact template and populate it with the same text. Again, make sure the wording for the new Fact item makes sense and then add it to the list.   
This rapid authoring technique sometimes requires that text be adjusted along the way.  For example if a Multiple Choice item has a correct answer of "All of the Above", the text that will populate the Term/Definition template will not make sense unless you modify the "Term or Answer" field.
Using an Item as the Basis for a New Item
To use an existing item as the starting point for a new item, locate the original item in the “Item List” at the bottom of the Edit menu. Pull down the context menu next to an item in the “Item List” and select Use as Basis for New Item. You will be returned to the Edit screen and the properties for the original item will be displayed in the form. The original title for the item will be modified slightly--for example, the number “2” will be added to the end of it. At this point you can rename the title and make any other changes you like. When finished, add or insert the item to the Item List. 

Copying Items from Another StudyMate Author File

From the Edit menu it is possible to copy items from another StudyMate Author file. Pull down the context menu next to any item in the “Item List” and select Copy from another file. This will open a window containing the files stored in the default directory (\StudyMate Projects). Select a “source” file by double-clicking the file name or by clicking it once and selecting [Open]. 

Tip: Before selecting a file, you can search the contents of the file by clicking on it once and then clicking the [Search] button. You can also view the items in a file -- prior to opening it -- by highlighting the file name and clicking the “Item List” button.  A specific item can be previewed by clicking the magnifying glass icon.

Once the source file is selected, a new window lists the items contained in it. An item can be selected by clicking the column furthest to the left. A checkmark will indicate that the item has been selected. When all the desired items have been selected, choose either the [Add to End of List] button or the [Insert into List] button to add the items to the currently open file between existing items in the “Item List”. 
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Overview of Settings Menu
The Settings Menu allows you to specify settings for each activity. There is a settings tab for the each item type (Fact, Term/Definition, and Multiple Choice/Calculated). The Other Settings tab allows you to select color settings, “accessibility” settings, and the language in which the interface for the StudyMate activities will appear (English, French, German, etc.). 
Settings for Item Types
Each StudyMate activity, except for Glossary and Challenge, has a setting that determines whether all items available for it will be displayed during each user session. The alternative is to display a subset of the available items during user sessions. For example, let’s say that the file contains 100 items that can be used with the “Pick A Letter” activity. Instead of including all 100 items each time the activity is played, you may prefer that 25 items be randomly selected each time. To do so, choose the “Select a fixed number” option and enter the number 25. (To clarify this example, all 100 items would be contained in the StudyMate file, but only 25 would be selected each time a student started the activity.) If you choose the option to have all items displayed during each user session, you have the choice of having the items delivered in random order or in the order that they appear in the StudyMate file.

Additional settings are available for the Quiz activity. To have feedback shown immediately after an answer is provided by the student, select the option “Show feedback after each question”. The “Show score after quiz” option is self-explanatory. The “Review missed questions” option will allow the student, upon completion of the quiz, to review each question that was missed.
Settings for Crosswords allow control of the number of puzzles (or “rounds”) included in published activity (ranging from 1-10). Another setting determines when puzzles are recompiled in the StudyMate authoring tool: each time the Preview task is started or only when a change has occurred to the StudyMate file. 

Finally, note that the Matching activity requires a minimum of 9 items and that the Challenge activity requires a minimum of 10 items.
Other Settings

The Other Settings tab, available from the Settings menu, provides language, template, color, and accessibility settings for the activities that are created with StudyMate Author. 

Language Settings
The user interface for the activities created with StudyMate Author can appear in six languages: Dutch, English, Finnish, French, German, and Spanish. To change the language setting within StudyMate Author, select the Settings menu, click the “Other Settings” tab and then choose the desired language from the pull-down list under “Language Settings.”

StudyMate.com Template Design
The background template used for activities published to StudyMate.com can be changed to one of several available options.  To change the background template design within StudyMate Author, select the Settings menu, click the “Other Settings” tab and then choose the desired background design from the pull-down list under “StudyMate.com Template Design.”

Color Settings

The color settings are only applicable when exporting activities as Adobe Flash modules and do not apply for activities published to StudyMate.com. A total of eight color templates are available in StudyMate Author. The default color setting is “Classic.” The color setting you choose will determine the look of the activities and games that are previewed or published with StudyMate Author. Note that if a “language setting” is anything other than English, that only the “Classic” color setting can be used. 

Accessibility Support
The color settings are only applicable when exporting activities as Adobe Flash modules and do not apply for activities published to StudyMate.com. Flash activities and games created with StudyMate Author allow navigation using the Tab/Enter keys, an important component of Section 508 (United States), SENDA Compliance (United Kingdom), and the Web Accessibility Initiative. 

The activities exported as Adobe Flash modules will display in “high contrast” mode if the “High contrast display...” setting is selected. 

Another setting allows the creation of an HTML page that contains alternative text for screen reader applications. The web page created will contain all of the underlying data from the StudyMate file and can be used with assistive technologies compatible with web browsers, including input, magnification and screen reader technologies. If images appear in the StudyMate file, they will be replaced with the alternate text entered by the content author.

More detailed information about StudyMate compliance with accessibility and assistive technologies is available from the Respondus web site at: http://www.respondus.com/products/accessibility.shtml.

Preview & Publish Menu
Overview

Preview Task
Publish Wizard
Publishing to a Learning Management System

Publishing to StudyMate.com Only

Exporting as Learning Objects

Print Options
Overview

The Preview & Publish Menu contains two tasks: Preview and Publish Wizard. The Preview task is used to preview the complete activities, while the Publish Wizard is used to generate and output the activities. 
Preview

The Preview task is similar to the preview option that appears in the Edit menu. The primary difference here is that all items in the file can be previewed, not just the item being edited. 

Upon selecting the Preview option, a browser-like window will appear and will show what the activities will look like when it is published from StudyMate Author. An “Activity” list appears at the top of the window and allows you to change the preview to a different activity. Note that the Activity list only displays the activities that are available for the file currently open. For example, if the StudyMate file only contains Multiple Choice items, the Preview task will only list the Practice Quiz and Challenge activities. Likewise, if the file only contains Term/Definition items, it will exclude the Practice Quiz and Challenge activities from the Preview task.

During the preview, two options are available at the top right corner of the Flash object: “Mark for Delete” and “Edit this Item”. “Mark for Delete” creates a list of items to be deleted once the Flash object is closed (you’ll be asked to confirm the deletions at that time). “Edit this Item” will close the Preview task immediately and display the item in the StudyMate Edit menu. 
The previewed activities can be viewed with the Settings selections applied or without the Settings applied. In most situations you’ll want to see how the Settings (such as question randomization) affect the display of the activities, but there are times when the original file order is preferred for previewing and editing purposes. Select the desired option before clicking the Preview button. 

Publish Wizard

The Publish Wizard is available from the Preview & Publish menu and will guide you through the steps of publishing or exporting the final StudyMate activities.
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The first page of the wizard lists the activities and games that can be included with the activities that are being output. Deselect any activity that you want excluded from the output.
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StudyMate Author provides three options for publishing the activities.

* Publishing to a Learning Management System.

StudyMate Author will publish the activities to the StudyMate.com service and directly provide a web link in the supported learning management systems including Blackboard 7.x or higher, Blackboard "WebCT" CE 8.0/Vista 8.0 and ANGEL 6.3 or higher. The other option is to publish Adobe Flash modules or SCORM modules directly to the supported learning management systems.
*Publish Only to StudyMate.com

StudyMate Author can publish the activities to the StudyMate.com service and provide a web link that can be inserted in any document or web page for access by students including mobile browser on smartphones and other mobile devices.
* Export as Learning Object (Flash, SCORM) for manual upload.
For situations where it is desired to have files on other learning management systems or web sites, or web-based content that does not have Internet access, the StudyMate activities can be exported as learning objects for manual uploading. The three formats are "HTML+SWF", "SCORM 1.2 package" and a "SWF Collection" of individual Flash activity modules.
Publishing to a Learning Management System.

[image: image23.png]Wizard

Publish to Learning Management System

1) Select aleaming system  [Backboard 7x-9x v

2) Select upload type
& Standard Upload fecommended)

Projects are published o StudyMate. com wih a ik to
from the onlive course. This offes the most fedbily for
Viewing actviies on compters,phones, and tabets.

" Adobe Flash package

Uploads 3 set of s tothe leaming system, including an
‘Adobe Fiash fle cortaining the activies. Some mobie
phones and tablets il be unable to view the activies.

© SCORM

Uploads a SCORM 1.2 archive to the learming systemthat.
includes an Adobe lash ie. Some mobile phones and tablets
wil be unable to view these projects. SCORM objects cannot be:
edted on the server, and cannot be appended or repiaced.

<Back. Next> Cancel Help.





Publishing to a supported learning management systems follows the same basic steps through the StudyMate Publish Wizard. The prime differences are how each LMS defines a content area and the initial server settings.

StudyMate Author provides three types of uploads:

Standard Upload (recommended)

Adobe Flash Package

SCORM

Standard Upload (recommended)

In the Standard Upload, StudyMate Author uploads the activity files to the StudyMate.com service and places a unique link to the activities in the online course. The Standard Upload provides the greatest flexibility as the activities are viewable in any modern desktop-based web browsers (Internet Explorer, FireFox, Safari, Google Chrome) and most mobile browsers on smartphones and other mobile devices such as "pad-type" tablets. The web link placed in the LMS to the activities on StudyMate.com can also be placed in any document or web page outside of the learning management system to provide the most widespread access to the StudyMate activities.
Adobe Flash Package

StudyMate Author can compile the activities into an Adobe Flash module along with supporting HTML and JavaScript files then upload the package into the learning management system. Students will need the Adobe Flash Player on their local system to view the StudyMate Author activities. Also, access to the activities will be restricted to only students who have access to the course in the learning management system.

SCORM

SCORM modules are special Flash packages with additional functions where a student score from any activity can be passed back to the learning management system grade book (only the score for the first attempt is saved). In order to use the SCORM option, the learning management system must have the SCORM “Content Player”. A disadvantage of SCORM packaging is that you cannot edit, append or replace a SCORM module once published to the server.
Creating Server Settings
The first time StudyMate Author is used to publish to a course in a supported learning management system, information must be entered about the LMS server and user account.

After selecting the learning management system and the StudyMate Author Upload Type, the next page of the Publish Wizard is where the server is selected. From the pull-down list of the labeled learning management system, select the “Add New Server” option.
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For each supported learning management system, the required server information may be slightly different but the steps are basically the same:

1. Log into a course on the LMS

2. Copy the URL to the server settings

3. Extract the server information

4. Enter a description for the server

5. Enter a User name and password
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As instructed on the screen, the first step is to open a web browser and to the appropriate login page, course listings page or course page (varies with LMS). Be sure that you are at the actual page. Copy the complete URL for this page and paste it in the field provided. (The easiest way to copy an URL that is displayed by a browser is to highlight it with your mouse, click the right mouse button, and select “Copy”. Then go to the appropriate field in StudyMate Author, click the right button again and select “Paste”.)

The second step requires you extract the server information. Upon clicking the “Extract” button, StudyMate Author will then fill in the Server Name and server details needed to connect to the course.

Now provide a short description for the LMS server. You can call the server anything you want, such as “My Course account”. If you access more than one LMS server, you will want to select a name that helps distinguish the two servers. 

Enter your User Name and Password. This information should be entered exactly as you would if using a web browser to access your course. If you want StudyMate Author to remember your User Name and Password for future sessions, select the “Remember my User Name...” checkbox.

Once the server settings have been entered click [OK] to close the window. Confirm that you have a live connection to the Internet and click [Next]. StudyMate Author will then attempt to connect to your LMS server. The hour-glass in Windows will appear momentarily. If the connection is successful, the next page of the wizard will appear. 
If the connection to the LMS course is unsuccessful, an error message will indicate that StudyMate Author was unable to connect to the server using the provided settings. If this occurs, troubleshoot it as follows: 

· Make sure you are running correct version of a supported learning management system.
· Make sure your connection to the Internet is working properly.

· Double-check the Password and User ID information. In fact, open your browser, go to the learning management server that hosts your account, and enter the identical information. This will confirm that your LMS Server is up-and-running and that your User ID and Password are correct. 

· Check the server settings are correct

· Make sure you are running the latest version of StudyMate Author (go to Help>Check for Update to see if a more current version is available)

Standard Upload to StudyMate.com

In the Standard Upload, the StudyMate Author activities are uploaded to StudyMate.com and a link is placed in the online course. After selecting the supported learning management system and choosing "Standard Upload (recommended), a Studymate.com account needs to be selected for the uploaded activities.

If there are no existing StudyMate.com accounts, select "- add new account -" to add an existing StudyMate.com account or create a new StudyMate.com account.
(See the StudyMate.com section on creating and managing StudyMate.com accounts.)
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Selecting a course and content area

Once you have selected a StudyMate.com account, a successful connection has been made to the LMS server and you have continued to the next page of the wizard, you are prompted to select a course. Click the pull-down list labeled “Course” to view the list of courses. Then select the course to which you want to publish web link to StudyMate.com. The Windows hourglass will again appear as StudyMate Author retrieves a list of the Content Areas contained in the course. 
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Now select a Content Area folder or sub-folder where StudyMate.com web link should be published. For instance, you might select the “Course Documents” folder or a sub-folder contained within it. Then click [Next] to continue.
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The final step prior to the actual publishing of the StudyMate activities is to specify a Project Name, a Title for Activities and a description or instructions for the activities. The Project Title and Title for Activities are required while the description is optional but recommended. In this section, there is the option to replace an existing project.

StudyMate Author has now gathered all the information needed to publish the StudyMate activities to StudyMate.com and place a web link in the course. Click [Next] to complete the publishing process.
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A status report is generated as StudyMate Author communicates with the LMS server. You will be told when the publishing step is complete. Then login to your course and confirm that everything is published to your expectation. You can also view the activities on StudyMate.com by copying and pasting the web link into a web browser or click on the "View Activities on StudyMate.com" to open the activities in a web browser.
Publishing to StudyMate.com

The Publish Only to StudyMate.com option will upload the StudyMate activities to StudyMate.com for the specified user account and provide a unique link that can be inserted into a document or web page.
The first step in the Publish Wizard is to select or create a StudyMate.com account.

When selecting "- add new account - " there will an option to create a brand new StudyMate.com account or add an account that already exists in StudyMate.com to the local installation of StudyMate Author.
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Creating a new StudyMate.com account
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In "Create New Account", after agreeing to the StudyMate.com Terms of Service, enter a valid email address and password. Before clicking the OK button, carefully check the Email address as it may be needed if one forgets the password and needs to request a new password. The StudyMate.com server can only return forgotten passwords to valid email addresses.
Adding an existing account

If there is an existing account on StudyMate.com, it can be added to the local list by selecting "Add an Existing Account".
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If one has forgotten the password, click on the "Forgot Password?" link to have the password resent from StudyMate.com.

Publishing activities to StudyMate.com

The final step prior to the actual publishing of the StudyMate activities is to specify a Project Name, a Title for Activities and a Description or Instructions for Activities. The Project Title and Title for Activities are required while the description is optional. In this section, there is the option to replace an existing project.
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StudyMate Author has now gathered all the information needed to publish the StudyMate activities to StudyMate.com. Click [Next] to complete the publishing process.
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A status report is generated as StudyMate Author communicates StudyMate.com. You will be told when the publishing step is complete. You can view the activities on StudyMate.com by copying and pasting the web link into a web browser or click on the "View Activities on StudyMate.com" to open the activities in a web browser.

Exporting as Learning Objects

The StudyMate activities can be exported as learning objects for manual uploading. The three formats are "HTML+SWF", "SCORM 1.2 package" and a "SWF Collection" of individual Flash activity modules.
After selecting the activities, in the next page "Select a publishing option:", select "Export as Learning Object (Flash, SCORM) for manual upload" to select one of the three options.

Exporting HTML+SWF Files
If you want to export a StudyMate activity so that it can be added to a web page, you must use a bit of HTML code. StudyMate Author will provide the needed HTML code when the SWF is exported. 
On the Export as a Learning Object for Manual Upload page of the wizard select the “HTML+SWF” option and click [Next].
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You are now prompted to enter the title that should appear on the HTML page (the title text will appear directly above the links to the Flash activities). Additional text, such as instructions to the student, can be added below the title.

Finally, click the [Save As] button and browse to a location on your hard drive to where the Flash file and HTML file should be saved. Once a folder is selected, click [Finish] to complete the export process.
In order to view the exported StudyMate activities, you must open the HTML file that was exported, not the .swf file itself. (The browser needs the HTML code, including settings contained in the HTML file, in order to properly start the Flash object.) 
The final step is to upload the files to your web server. You can either upload both the HTML page, the SWF file and a supporting JS file to the same folder on the web server, or you can add the body of the HTML file to one of your own pages and upload only the SWF file and JS file. (Note: These files must be placed in the same folder as the HTML file). 

Exporting a SCORM Package

The Shareable Content Object Reference Module (SCORM) is a set of specifications that enables the reuse and migration of web-based learning content in different environments and products. Many of the leading course management systems and learning management systems support SCORM, including Blackboard Learn, Blackboard Vista/CE, ANGEL Learning, and Moodle. 

The Publish Wizard in StudyMate Author includes a SCORM option within the direct publishing options for the supported learning management systems. It’s easier to use these integrated publishing options for SCORM, rather than manually exporting it as a SCORM 1.2 package, as is required for use with other SCORM-compliant systems. 

For other e-learning systems and other SCORM-compliant systems, the SCORM package will need to be manually exported and uploaded to the SCORM-compliant system. StudyMate Author will create the SCORM package with all the appropriate files and "wrappers" to use the SCORM module without any additional configuration or programming.

StudyMate supports the “grade” feature in SCORM, which allows a score to be passed from the Flash object to the e-learning system. SCORM only allows one grade to be passed from the object to an e-learning system's grade book.  By default, the “Quiz” activity is used for generating the grade, but it is possible to designate a different StudyMate activity for this purpose within the Publish Wizard. 
StudyMate also supports the “time” feature which indicates how much time a student spent on each StudyMate activity. However, this is an optional feature in the SCORM specification and it isn’t supported by many e-learning systems.
Exporting a SWF “Collection”
Exporting StudyMate objects to a SWF Collection allows for the creation of individual activities that do not require an accompanying HTML page for "launching" purposes. (Exporting a SWF Collection is an advanced feature and it is important to know that the HTML + SWF publish option is a better choice for most exporting purposes.)  
When exporting to a SWF Collection each activity is published as a separate Flash file, such as History_flash.swf (Flash Cards) or History_quiz.swf (Quiz).  This approach makes the overall size of the collection much larger as each file is nearly as large as the single shared SWF. 

Print Options

StudyMate Author allows you to print questions and items or save them to a file for further enhancement and printing. To begin, go to the Preview and Publish menu in StudyMate Author and select the Print Options tab.

The screen now displays the printing options available in StudyMate Author. The first step is to select the Formatting options that are desired, including the type and range of items to be included in the printout.

The second step allows you to specify the “header” information to appear at the top of pages, such as a person’s name, the file name, or the date. 

In the final step, you can preview the file (formatted selections will be displayed), save the file to a MS Word, rich-text or plain text format, or send the file directly to a printer. 

StudyMate.com tab
The StudyMate.com tab allows one to manage projects that have already been published to StudyMate.com along with managing StudyMate.com accounts.
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Managing Projects

Clicking on "Manage Projects" will bring up a new window listing all the projects currently located on StudyMate.com.
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The pull down listing at the top of the window will allow changing between the different StudyMate.com accounts.

Active Projects tab

The main tab "Active Projects", lists all the projects currently at StudyMate.com under the account. Clicking on the column headings Project Name, Modification Date or Title/Description, will sort on the column.

Clicking on the project name will open a browser window to show the landing page of the StudyMate Author project and the activities selected during publishing.
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To the left of each project title is an action menu to manage a specific project. Select the item to start the action.

Properties - Lists the Creation Date, Last Access Date, URL, the StudyMate Source File, Number of items in the file and if the project is linked from an LMS.

Go to URL - Will open a browser window and display the landing page of the StudyMate project.

Retrieve Project - Will download the items back into StudyMate for editing and updating.
Disable Project - Will prevent the students from accessing the StudyMate activities even if they have bookmarked the URL.
Delete Project - will permanently delete the project from StudyMate.com. Use with care if the original StudyMate file is not available. It is highly recommended to use Retrieve Project as a backup before deleting a project.
Disabled Projects tab
The Disable Projects tab lists all the currently disable projects. Two additional items in the Action menu next to each disable project name are "Restore Project using original URL" and "Activate Project with new URL". Using either action will place the project back into the Active Projects listing.

Deleted Projects tab

The Delete Projects tab list all the delete projects. It is intended only as a reference or reminder as to which projects have been deleted. There is no option for recovering deleted projects. The only Action menu item is "Remove from List" to remove the project title from the listing.
Additional options

Additional options in Manage Projects include:

"Search On:" that will search for terms in the Title and Description columns.
"Expanded View" to display the project properties under each project title.

"Page Navigation" in the lower right corner.

Account Settings
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The Account Settings is where one can create new accounts on StudyMate.com, add existing StudyMate.com accounts to the local StudyMate Author, modify the email address, modify the password, delete the account from the local StudyMate Author and permanently delete an existing StudyMate.com account.
When entering a new email address or modifying an existing email address, it is important to verify the email address before clicking OK. An incorrect email address will not allow for password recovery and cannot be retrieved by Respondus Technical Support.
Other Tools & Features

Overview

Preferences
Save As… (Copy)
Save As… (StudyMate Class Server XML) 
Item Title Tool
Check for Update
Overview

There are several additional tools in StudyMate Author that offer a range of functions. Each of these is discussed below. 

Preferences

Preference settings, which can be accessed from the File menu bar, contain three tabs: General, Edit and Auto-save.

General Tab

StudyMate Projects folder location - allows you to specify the default location of the StudyMate Projects folder. If the folder is moved in Windows, it’s essential that the location be updated here.
StudyMate Publish folder location - sets the folder location when publishing local copies of StudyMate activities.
Check for Update - determines whether StudyMate Author will automatically check for product updates. The checking occurs every few weeks.
Default Author Name – allows you to enter or change the default author name for StudyMate project files.

Language Setting - specifies the language setting to be used in the interface when new activities files are created.
Edit tab

Randomize Answer Choices - determine whether the answer choices for multiple choice questions will be randomized when questions are imported or created new. Note that changing this setting doesn’t affect questions that are already contained in the project, only new questions that are added to it. 

Automatically Create New Items – will create new Term/Definition items when a multiple choice item is created, or create new Fact items when a Term/Definition item is created. 
Auto-Save tab

Turn off automatic saving – StudyMate author will not automatically save after entering new items or editing existing items.  You need to either manually click on the Save icon in the tool bar or select the “Save” option from the File menu to save the items back to a file in the StudyMate Projects folder.
Save After: - Provides options to automatically save an item to the file after adding new items or making changes to existing items.
Save As… (Copy)
The Save As… tool, located on the File pull-down menu, can be used to create a copy of the currently open project file. After the project is saved, StudyMate Author will begin using the newly named project file.
If you plan to move a StudyMate project to another computer, and if the StudyMate project contains embedded objects such as equations or images, be sure to use the “zip” feature that’s available in Save As…  (otherwise these objects will be missing when the file is opened on the other computer). With the Save As… window displayed, change the “Save as Type” pull-down list to “zip archive”. All files associated with the StudyMate project will be stored in the zip archive. 
Save As… (StudyMate Class Server XML)

The Save As… tool, located on the File pull-down menu, can also be used to save Fact, Term/Definition, and multiple choice questions in StudyMate Class Server XML format. The StudyMate Class Server XML format can be imported into a StudyMate Class Server instance.
Note that the StudyMate Class Server does not support some image file types and other media file types. Items that contain these unsupported elements will not be exported in the XML file, nor will Calculated questions.

The StudyMate Class Server XML can also be imported into Respondus 4.x, although the Fact question types will not be imported since they are not supported in Respondus 4.x.  

Item Title Tool

There are situations where it is desirable to rename all the titles in the StudyMate project file to provide a consistent look or numbering sequence. For example, if questions are copied or imported from a variety of sources the resulting titles may look inconsistent and haphazard. 

The Item Title Tool, located under File on the menu bar, lets a “stem” (or prefix) be specified for item titles. Consecutive numbering will automatically be generated for the text that appears after the stem, beginning with 1 (or 01, or 001, etc.). For example, if you enter “Chapter1-” as the stem text, and then select “001” as the format for the numbering scheme, the title for the first item will be changed to Chapter1-001, the title for the second item will be changed to Chapter1-002, and so on. If a range is specified for the titles being changed, even more specific titles can be provided throughout the file. For instance, questions 1-20 might use the stem “Ch1-Unit1-” and questions 21-30 might use the stem “Ch1-Unit2-” and so forth.

Properties

Select Properties from File on the menu bar to view or change the properties for the currently open file. There are three fields that can be edited: Author, File Description, and Keywords. 

Check for Update

The “Check for Update” tool, located on the Help menu bar, provides an easy way to see if an update is available for StudyMate Author. Every few weeks, StudyMate Author will generate a message that asks whether it can check for an update. No information about your computer hardware and software is collected by Respondus, Inc. during this process. Instead, the StudyMate Author software retrieves information from Respondus.com and will display a message if an update is available. You will then have the choice of upgrading to the latest version of the software. 

To manually check for a software update, select the “Check for Update” option from the Help pull-down menu (you will need a live Internet connection). StudyMate Author will instantly return a message indicating whether an upgrade is available. If an upgrade to StudyMate Author is available, you can let it download the required file(s) automatically and update the software for you. This is the easiest way to apply a patch or upgrade.

If you prefer that StudyMate Author does not periodically prompt you to check for an update, go to the File menu, select Preferences, and unselect the appropriate checkbox under the General tab. 

Disclaimer of Warranty  

While Respondus, Inc. has tried to ensure the dependability of the software and documentation, it is provided "as is" without warranty of any kind.  Agents of the supplier may have made statements about this software.  Any such statements do not constitute warranties and shall not be relied on by individuals in deciding to use the program.  

Because of the diversity of conditions and hardware under which this program may be used, no warranty of fitness for a particular purpose is offered. Test the program thoroughly before relying on it. You assume the entire risk of using the program. Respondus, Inc. shall not be liable for any expense, claim, liability, loss, or damage (including any incidental or consequential damage), loss of profits, loss of reputation, or any loss whatever direct or indirect, by you from either the use of or the inability to use the software. 

Copyright, Ownership, and Use of Software  

All software, with exception of the Equation Editor, remains the property of Respondus, Inc. The software and written materials are copyrighted.  This license is not a sale of the original software or any copy.  You own the physical media on which the software is originally or subsequently encoded, but Respondus Inc. retains title and ownership of the software on all media. 

You are not permitted to install the executable code version of this product on a network server or virtual server. You may not customize the Product. Except as otherwise permitted by written consent, you may not: (i) modify or create any derivative works of the Product or documentation, including translation or localization; (ii) decompile, disassemble, reverse engineer, or otherwise attempt to derive the source code for the Product; (iii) redistribute, encumber, sell, rent, lease, sublicense, or otherwise transfer rights to the Product; or, (iv) remove or alter any trademark, logo, copyright or other proprietary notices, legends, symbols or labels in the Product.

© 2004-2012 by Respondus, Inc. All Rights reserved. The Sentry Spelling-Checker Engine is copyrighted by Wintertree Software, Inc.

Respondus and StudyMate are registered trademarks of Respondus, Inc. All other trademarks are the property of their respective owners.


Appendices

Appendix A: The StudyMate Author Standard Format for Importing Items

StudyMate Author allows you to import multiple choice questions, term/definition items and fact items from a file. The items must be organized in a format that is acceptable to StudyMate Author in one of the following formats: MS Word 2007-2010 document (.docx), MS Word 97-2003 document (.doc), Rich Text File (.rtf), Plain Text file (.txt). The MS Word 97-2003(.doc) and Rich Text File (.rtf) files cannot contain images or embedded objects, such as tables. (If a StudyMate warning indicates that the document being imported contains images or embedded objects, the easiest way to strip these items is to save the file to a Plain Text “.txt” format prior to importing the file.)
Note: Importing questions from the Microsoft Word 2007-2010 .docx format requires that Word 2007 or Word 2010 be installed on the same computer.  The .docx format has better support for importing text with formatting like auto-numbers and auto-letters.

Format Requirements for Importing “Multiple Choice” Files

The Standard Format for multiple choice items have required elements and optional elements, each of which is described next.

“Standard Format” for Multiple Choice Imports: Required Elements
Each question must begin with a question number, followed by either a period “.” or a parentheses “)”. 


Example:   
3)
Example: 
3.

The question wording must follow the question number. (Note: at least one space should be between the question number and the question wording.)


Example:
3) Who determined the exact speed of light?

Example:
3. Who determined the exact speed of light?
Each answer must begin with a letter (A-J) followed by a period “.” or a parentheses “)”. 


Example: 
3) Who determined the exact speed of light?




a. Albert Einstein




b. Albert Michelson




c. Thomas Edison




d. Guglielmo Marconi

“Standard Format” for Multiple Choice Imports: Optional Elements
A Title can be imported with each multiple choice question. If a title is not provided for a question, the first set of characters of the question wording will be used as the question title in StudyMate Author. Titles must be placed at the beginning of a question and begin with “Title:” followed by the actual text for the title. If the title exceeds 20 characters, the remaining characters will be dropped during the import. 


Example:
Title: Speed of Light
 
3) Who determined the exact speed of light?




a. Albert Einstein




b. Albert Michelson




c. Thomas Edison




d. Guglielmo Marconi

The correct answer for a multiple choice question can be indicated in two ways. First, you may place an asterisk (*) directly in front of the answer choice (do not put a space between the asterisk and the answer choice).


Example: 
Title: Speed of Light
3) Who determined the exact speed of light?




a. Albert Einstein




*b) Albert Michelson




c) Thomas Edison




d. Guglielmo Marconi

The second option is to place a list of correct answers at the end of the file. The list must begin with the word “Answers:” and must be positioned at the end of the file. 

Example: 
Answers:

1. A




2. C




3. B

Note that only letters “A-J” should be used to indicate a correct answer since StudyMate Author activities only support a maximum of 10 answer choices per question. Also note that any text that appears after the answer list will be ignored.

If neither of the above methods is used to specify a correct answer, StudyMate Author will automatically select the letter “A” as the correct answer. You will be warned if a question does not have a correct answer specified for it prior to completing the import. 

Answer “Feedback” can be imported with multiple choice questions by placing the feedback immediately after the question wording and beginning the line with the “@” symbol. (Note: There must be at least one space between the @ symbol and the feedback text.)


Example: 
Title: Speed of Light
3) Who determined the exact speed of light?

@ Albert Michelson was the first American to win the Nobel Prize in Physics (1907) for his measurements of the speed of light. His experiments laid the groundwork for Einstein’s Theory of Relativity.




a. Albert Einstein




*b) Albert Michelson




c) Thomas Edison




d. Guglielmo Marconi

The “Topic” and “Difficulty” level of Multiple Choice questions can also be specified in a file prior to the import. This is explained below in the section “Importing a Topic or a Difficulty Level.”

Format Requirements for Importing “Term/Definition” Items

The “Term/Definition” items are formatted according to one of the two main formats supported by StudyMate Author: a “standard format” as described next or in an “Alternate glossary” format.  A third optional format is available for glossary files exported from the Blackboard Learn LMS.
“Standard Format” for Term/Definition Imports
Standard Format syntax for Term/Definition items is as follows:


<term1>


<definition1>



<blank line1>



<blank line 2>


<term2>


<definition2>

This translates into the following example:



Albert Michelson



Determined the exact speed of light



Albert Einstein



Developed the General Theory of Relativity

It’s important that at least two blank lines appear after each item. That’s because a single blank line indicates a new paragraph for the same item, not a new item altogether. Also note that enhanced formatting such as bold and italics will be retained by StudyMate Author when items are imported from a .rtf or .docx/.doc file. However, StudyMate Author will prevent you from importing .rft or .doc files that contain images or embedded objects, such as tables. (If StudyMate Author warns you that the document being imported contains images or embedded objects, it may be easier to export the file to a .docx file or as .txt format so that these objects are automatically converted to a suitable format, or dropped altogether.)

The “Topic” and “Difficulty” level of Term/Definition items can be specified in a file prior to importing. This is explained below in the section “Importing a Topic or a Difficulty Level.”

Importing Alternate Glossary Files

StudyMate Author can import glossary files as Term/Definition items. The formatting is relatively simple:


:<term>


<definition>

Note the colon (“:”) at the start of the term.

Here’s a specific example: 



:Albert Michelson



Determined the exact speed of light



:Albert Einstein



Developed the General Theory of Relativity

Note that only one blank line is required between items for this format, unlike the “Standard Format” described previously.  

Importing Blackboard Learn Glossary Files

Blackboard Learn has a glossary tool that can export items in .txt format. These files can be imported by StudyMate Author as Term/Definition items. The formatting is relatively simple:


"<term>"<tab>"<definition>"<linefeed>"<term>"<tab>"<definition>"<linefeed>

Note the quotes that surround the term and the definition.
Here’s a specific example: 

"Albert Michelson"<tab>"Determined the exact speed of light"<linefeed>"Albert Einstein"<tab>"Developed the General Theory of Relativity"<linefeed>

Format Requirements for Importing “Fact” Items

A Fact item is essentially a fact or brief text that has Fact associated with it. 

StudyMate Author can import Fact items from a MS Word document (.docx, .doc), a rich-text file (.rtf), or a text file (.txt). However, the file must first be organized in the “Standard Format,” which is actually quite simple:

 
<fact1>



<blank line1>



<blank line 2>


<fact2>

This translates into the following example:



Albert Michelson determined the exact speed of light



Albert Einstein developed the General Theory of Relativity

It’s important to remember that this formatting requires at least two blank lines between each item. That’s because a single blank line indicates a new paragraph for the same item, not a new item altogether. Also note that enhanced formatting such as bold and italics will be retained by StudyMate Author when items are imported from a .rtf or .docx/.doc file. However, StudyMate Author will prevent you from importing .doc or .rtf files that contain images or embedded objects. (If StudyMate Author warns you that the document being imported contains images or embedded objects, it may be easier to export the file to a .docx file or as a .txt format so that these objects are automatically converted to a suitable format, or dropped altogether.)

The “Topic” and “Difficulty” level of Fact items can be specified in a file prior to importing. This is explained below in the section “Importing a Topic or a Difficulty Level.”

Format Requirements for Importing “Mixed Items”(MS Word 2007-2010 .docx files only).
When importing MS Word 2007-2010 “.docx” files, Fact, Term/Definition and Multiple Choices items can be included in the same file by including a TYPE: identifier. To assign a TYPE to items in a file, place the following tag before the items: 

TYPE:  <enter type here>
The TYPE tags are:

M – Multiple choice questions

T – Term/Definition

F – Facts
For example, to define the following two items as multiple choice questions, the following formatting would be used: 



TYPE: M


3) Who determined the exact speed of light?



a. Albert Einstein



*b. Albert Michelson



4) Who formulated the General Theory of Relativity?



*a. Albert Einstein



b. Albert Michaelson

The TYPE identified will be applied to consecutive items until a new TYPE: is encountered in the file. For example:
TYPE: M

3) Who invented the incandescent light bulb?

a. Alexander Graham Bell

b. George Eastman

*c. Thomas Edison

d. Samuel Colt

TYPE: T

Alexander Graham Bell

Invented the telephone the telephone and is also credited for inventing the metal detector and hydrofoil boat.
TYPE: F

Alexander Graham Bell invented the telephone.
The TOPIC and DIFFCULTY tags can also be used in the Mixed Item Type import following the same format as the import of specific items. This is explained below in the section “Importing a Topic or a Difficulty Level.”
Importing a ‘Topic’ or a ‘Difficulty’ Level

The “Topic” and “Difficulty” level of a Multiple Choice, Term/Definition, or Fact item can be specified in a file prior to importing it. To assign a topic to multiple items in a file, place the following tags before and after the items, respectively: 


TOPIC:  <enter topic name here>


TOPICEND: 

For example, to place the following two items into a topic called “Scientists” the following formatting would be used: 



TOPIC: Scientists



3) Who determined the exact speed of light?



a. Albert Einstein



*b. Albert Michelson



4) Who formulated the General Theory of Relativity?



*a. Albert Einstein



b. Albert Michaelson



TOPICEND:

If you prefer to designate a topic for each item being imported, it isn’t necessary to include the “TOPICEND:” tag after each question. For example, the following formatting is acceptable where a different topic is being assigned to both items:



TOPIC: Michelson



3) Who determined the exact speed of light?



a. Albert Einstein



*b. Albert Michelson



TOPIC: Einstein



4) Who formulated the General Theory of Relativity?



*a. Albert Einstein



b. Albert Michaelson



TOPICEND:

Just remember to include a “TOPICEND:” tag any time you don’t want the topic to be attributed to subsequent questions or items. 

A similar approach can be used to designate a 1-5 difficulty level (1=low, 5=high) for items being imported. 

DIFFICULTY: <enter a number between 1 and 5>

DIFFICULTYEND:

For example, to assign the difficulty level of two questions to “3” the following formatting would be used:



DIFFICULTY: 3



3) Who determined the exact speed of light?



a. Albert Einstein



*b. Albert Michelson



4) Who formulated the General Theory of Relativity?



*a. Albert Einstein



b. Albert Michaelson



DIFFICULTYEND:

If you prefer to designate a difficulty level for each item being imported, it isn’t necessary to include the “DIFFICULTYEND:” tag after each question. For example, the following formatting is acceptable where a different difficulty level is being assigned to both items:



DIFFICULTY: 5



3) Who determined the exact speed of light?



a. Albert Einstein



*b. Albert Michelson



DIFFICULTY: 3



4) Who formulated the General Theory of Relativity?



*a. Albert Einstein



b. Albert Michaelson



DIFFICULTYEND:

However, remember to include a “DIFFICULTYEND:” tag any time you don’t want the difficulty level to be attributed to subsequent questions or items. 

One final note about the Topic and Difficulty tags. If you are importing the alternate glossary file, only one topic and/or difficulty level can be specified in the file. In addition, the first tag must appear at the top of the text file. 

� Calculated questions are not currently supported with StudyMate.com activities.
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